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1. 概要 

 

本書は、ES920LR3EB/ES920LR3A1EB 評価ボードを使用した 920MHz 帯無線通信用ソフトウェアの

開発環境について記述します。 
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2. 開発環境 

 

ES920LR3EB/ES920LR3A1EB 評価ボードの使用方法として、下記の 3 通りの方法があります。 

お客様の用途に応じてお選びください。 

 

●方法 1 弊社提供ソフトウェアをそのまま使用する場合 

●方法 2 有償の統合開発環境にて弊社提供ソフトウェアをカスタマイズして 920MHz 帯無線通

信ソフトウェアを開発する場合 

(IAR システムズ社製 IAR Embedded Workbench for Arm 使用) 

●方法 3 無償の統合開発環境にて弊社提供ソフトウェアをカスタマイズして 920MHz 帯無線通

信ソフトウェアを開発する場合 

(STMicroelectronics 社製 STM32CubeIDE 使用) 
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2.1. 必要機材 

 

必要な機材は次の通りです。 

 

表 2-1 必要機材一覧 

 

 

※1. 無線モジュールが外付けアンテナタイプの場合は、外付けアンテナと同軸ケーブルが必要です。

(ES920LR3SDK1 に付属しています) 

※2. ファームウェアの書込みをする際に必要です。 

Ex) モジュールを新しいバージョンのソフトウェアに更新する場合 

Ex) モジュールをカスタマイズしたソフトウェアに更新する場合 

※3. IAR Embedded Workbench for Arm を使用する場合、デバッガは I-jet か ST-LINK/V2 のいずれ

かが使用可能です。(但し、STM32CubeIDE と I-jet の組み合わせでは使用できません) 

※4. ST-LINK/V2 を評価ボード(ES920LR3EB)に接続する際、評価ボードコネクタのピン数(10pin)に

合わせるための変換アダプタが別途必要です。 

市販品の「ARM-JTAG-20-10」(Olimex LTD 製)にて動作実績があります。 

※5. ピンアサインやクロック設定等を変更する場合、自動コード生成ツール(STM32CubeMX)を使用

することで GUI 画面での設定とコード生成が可能です。 

Ex) 本モジュールから外部のデバイス(センサー等)を制御する場合 
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2.2. 開発環境構築の流れ 

 

開発環境構築の流れを下記に示します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

図 2-1 開発環境構築の流れ 

 

※ 方法１を選択した場合は、④以降の手順は不要です。 

  

● 開発用 PC の準備 ● 

① USB ドライバのインストール 

② ターミナルソフトウェアのインストール 

③ FlashROM 書込みツールのインストール 

● 統合開発環境の準備 ● 

④ 統合開発環境(IAR Embedded Workbench for Arm／

STM32CubeIDE)のインストール 

⑤ 自動コード生成ツール(STM32CubeMX)のインストール 

⑥ ソフトウェアのビルド 

● 動作確認 ● 

⑦ 統合開発環境によるデバッグ 
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● 開発用パソコン ● 

● 開発用パソコン ● 

 

2.3. 環境構築例 

 

(1) 方法 1 (弊社提供ソフトウェアをそのまま使用する場合) 

 

ES920LR3EB 

ターミナルソフトウェア 

 

microUSB 

 

 

 

 

 

図 2-2 方法 1 (弊社提供ソフトウェアをそのまま使用する場合) 

 

(2) 方法 2 (EWARM を使用してカスタマイズする場合) 

 

 

ターミナルソフトウェア 

ES920LR3EB 

 

 

microUSB 

 

 

 

 

統合開発環境(EWARM) 

 

 

 

 

 

 

デバッガ(I-Jet 又は ST-LINK/V2) 

図 2-3 方法 2 (EWARM を使用してカスタマイズする場合) 
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● 開発用パソコン ● 

 

(3) 方法 3 (STM32CubeIDE を使用してカスタマイズする場合) 

 

 

ターミナルソフトウェア 

 

ES920LR3EB 

 

 

 

microUSB 

 

 

統合開発環境 (STM32CubeIDE) 

  

 

 

 

 

 

                         デバッガ(ST-LINK/V2) 

 

図 2-4 方法 3 (STM32CubeIDE を使用してカスタマイズする場合) 
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3. シリアル接続環境のインストール 

 

3.1. USB ドライバのインストール 

 

開発 PC から ES920LR3EB を操作する為、USB ドライバをインストールします。 

 

3.1.1. 手順 1 USB-シリアル変換チップ(CP2102N)用ドライバのダウンロード 

 

下記サイトにアクセスし、USB-シリアル変換チップ用ドライバをダウンロードしてください。 

https://www.silabs.com/documents/public/software/CP210x_Universal_Windows_Driver.zip 

ダウンロード後、任意のフォルダに解凍してください。 

 

3.1.2. 手順 2 開発パソコンに USB ケーブルを接続 

 

開発 PC に USB ケーブル(ES920LR3EB)を接続します。 

自動的にドライバのインストールが始まりますが、始まらない場合は以降の手順を実行してください。 

 

3.1.3. 手順 3 USB ドライバのインストール 

 

デバイスマネージャを開き、USB Serial Port が存在する事を確認します。 

 

 

図 3-1 デバイスマネージャ画面 1 

  

https://www.silabs.com/documents/public/software/CP210x_Universal_Windows_Driver.zip
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USB Serial Port で右クリックをし、「ドライバーソフトウェアの更新(P)...」を選択します。 

表示される画面で「コンピューターを参照してドライバーソフトウェアを検索します(R)」をクリック

します。 

 

 

図 3-2 ドライバーソフトウェアの更新画面 1 

 

ダウンロードした USB ドライバを解凍した場所を選択し、「次へ」をクリックします。 

 

 
図 3-3 ドライバーソフトウェアの更新画面 2 
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3.1.4. 手順 4 COM ポートの確認 

 

USB ドライバのインストールが完了し、COM ポートとして認識される事を確認します。 

 

図 3-4 デバイスマネージャ画面 2 
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3.2.  ターミナルソフトウェアのインストール 

 

開発 PC から ES920LR3EB を操作する為にターミナルソフトウェアを使用します。 

ターミナルソフトウェアには、任意のフリーソフトウェア(TeraTerm 等)をご使用ください。 

下記にターミナルソフトウェアの設定を一覧にします。 

 

表 3-1 ターミナルソフトウェア設定一覧 

 設定項目 設定値 

1 改行コード(受信) CR 

2 改行コード(送信) CR+LF 

3 ローカルエコー 使用 

4 ポート ES920LR3EB 接続ポート番号 

5 ボーレート 115200kbps 

6 データ 8bit 

7 パリティ None 

8 ストップ 1bit 

9 フロー制御 None 

※ ボーレートの設定は変更する事が可能です。 
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4. FlashROM 書込み方法 

 

4.1. FlashROM 書込みツールのインストール 

 

FlashROM 書込みツールには、STMicroelectronics 社製の書込みツール(STM32CubeProgrammer)を

使用します。 

 

STMicroelectronics 社のサイトにアクセスし、FlashROM 書込みツール(STM32CubeProgrammer)を

ダウンロードしてください。 

https://www.st.com/ja/development-tools/stm32cubeprog.html 

※ダウンロードの際にはユーザ登録が必要になります。 

 

 

図 4-1 STMicroelectronics 社サイトからの Flash 書込みツールダウンロード 

 

ダウンロードしたファイルを任意のフォルダに解凍してインストーラを実行し、インストーラの指示

にしたがってインストールしてください。 

  

https://www.st.com/ja/development-tools/stm32cubeprog.html
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4.2. FlashROM メモリマップ 

 

ES920LR3 の内蔵 FlashROM(256kbyte)はアドレス 0x08000000-0x0803FFFF 番地に割り当てられてい

ます。 

新規にソフトウェアを開発する場合、この番地内に配置してください。 

 

 

図 4-2 FlashROM メモリマップ 

 

※ES920LR3 の弊社提供ソフトウェアは、Configuration Parameter の保存領域には FlashROM 

(0x0803F800-0x0803FFFF)を使用しています。 

  

0x8000000 

 

0x8013FFF 

0x8014FFF 

 

0x803FFFF 
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4.3. GUI ツールを使用した FlashROM 書込み 

 

4.3.1. 手順 1 ブートローダ起動設定 

 

評価ボード(ES920LR3EB)の J3 ジャンパピンを NO 側でショートしてください。 

 

 

 

 

 

 

図 4-3 ブートローダ起動のためのジャンパ設定 

 

※  評価ボードをご使用でない場合(モジュールを単体でご使用の場合)は、モジュール本体の

pin3(BOOT0 ピン)を VCC とショートするなどして High になるようにしてください。 

 

4.3.2. 手順 2 評価ボードの接続 

 

評価ボード(ES920LR3EB)と開発 PC を micro USB ケーブルで接続します。 

 

 

 

 

 

 

 

 

 

 

 

図 4-4 評価ボードと開発 PC を接続 

 

ターゲットをリセットすると、モジュール内部で FlashROM 更新用のブートローダが起動します。 
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4.3.3. 手順 3 書込みツール起動 

 

スタートメニューから STM32CubeProgrammer を起動します。 

 

4.3.4. 手順 4 ターゲットへの接続 

 

右上の【ST-LINK】の右の▼を押下して【UART】を選択します。 

（既に【UART】が選択されている場合はそのままで構いません） 

 

図 4-5 STM32CubeProgrammer 画面 1 
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【UART configuration】で下記に設定します。 

・Port：COM ポート番号を選択 

・Baudrate：115200 

・Parity：Even 

 

図 4-6 STM32CubeProgrammer 画面 2 

 

右上の【Connect】を押下してターゲットと接続します。 

 

図 4-7 STM32CubeProgrammer 画面 3 
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4.3.5. 手順 5 FlashROM の書込み 

 

画面左上のメニューボタン(〓)を押下して、【Erasing&programming】を選択します。 

 

図 4-8 STM32CubeProgrammer 画面 4 

 

File path の Browse を押下して、FlashROM に書込む実行ファイル(.hex)を選択します。 

【Verify programming】にチェックを入れ、【Start Programming】を押下します。 

 

図 4-9 STM32CubeProgrammer 画面 5 
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【File download complete】が表示されたら OK を押下してください。 

 

 
図 4-10 STM32CubeProgrammer 画面 6 

 

【Download verified successfully】が表示されたら OK を押下してください。 

 

 
図 4-11 STM32CubeProgrammer 画面 7 

 

4.3.6. 手順 6 ターゲットからの切断 

 

右上の【Disconnect】を押下してターゲットと接続します。 

 

図 4-12 STM32CubeProgrammer 画面 8 

 



特定小電力無線モジュール ES920LR3 

ソフトウェア開発環境説明書 

p. 21 

株式会社 EASEL 

 

以上で FrashROM への書込みは完了です。 

 

4.3.7. 手順 7 ブートローダ起動設定の解除 

 

手順 1 で設定したジャンパピンを元に戻してください。 

 

 

 

 

 

 

図 4-13 ブートローダ起動のためのジャンパ設定 

 

※  評価ボードをご使用でない場合(モジュールを単体でご使用の場合)は、モジュール本体の

pin3(BOOT0 ピン)をオープンにするか Low にしてください。 

 

ターゲットをリセットすると、新しいプログラムで起動します。 
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4.4. コマンドラインツールを使用した FlashROM 書込み 

 

4.4.1. 手順 1 ブートローダ起動設定 

 

評価ボード(ES920LR3EB)の J3 ジャンパピンを NO 側でショートしてください。 

 

 

 

 

 

 

図 4-14 ブートローダ起動のためのジャンパ設定 

 

※  評価ボードをご使用でない場合(モジュールを単体でご使用の場合)は、モジュール本体の

pin3(BOOT0 ピン)を VCC とショートするなどして High になるようにしてください。 

 

4.4.2. 手順 2 評価ボードの接続 

 

評価ボード(ES920LR3EB)と開発 PC を micro USB ケーブルで接続します。 

 

 

 

 

 

 

 

 

 

 

 

図 4-15 評価ボードと開発 PC を接続 

 

ターゲットをリセットすると、モジュール内部で FlashROM 更新用のブートローダが起動します。 
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4.4.3. 手順 3 コマンドプロンプト起動 

 

コマンドプロンプトを起動し、FlashROM 書込みツールをインストールしたフォルダ直下の bin フォ

ルダにカレントディレクトリを移動します。 

C:\Program Files\STMicroelectronics\STM32Cube\STM32CubeProgrammer\bin 

 

図 4-16 コマンドプロンプト起動画面 

 

※インストールしたフォルダの違いによって、イメージが異なる場合があります。 
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4.4.4. 手順 3 書込みツール実行 

 

上記のフォルダに含まれる STM32_Programmer_CLI.exe を起動します。 

起動オプションは下記の通り指定してください。 

 

STM32_Programmer_CLI -c port=COM5 br=115200 P=EVEN -d C:\work\ES920LR3.hex -v 

                            (COM ポート番号)                (書込み対象ファイル) 

※ COM ポート番号は環境に合わせて設定してください。 

※ 書込み対象ファイルは実行ファイルを保存したパスを指定して下さい。 

 

 

図 4-17 FlashROM 書込みツール実行画面 1 

 

※コマンドオプションの詳細は、STM32_Programmer_CLI -? を入力する事で確認できます。 
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図 4-18 FlashROM 書込みツール実行画面 2 

 

「Download verified successfully」が表示されれば成功です。 
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4.4.5. 手順 5 ブートローダ起動設定の解除 

 

手順 1 で設定したジャンパピンを元に戻してください。 

 

 

 

 

 

 

図 4-19 ブートローダ起動のためのジャンパ設定 

 

※  評価ボードをご使用でない場合(モジュールを単体でご使用の場合)は、モジュール本体の

pin3(BOOT0 ピン)をオープンにするか Low にしてください。 

 

ターゲットをリセットすると、新しいプログラムで起動します。 
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5. 統合開発環境でのソフトウェア開発 

 

5.1. ST-LINK/V2 用ドライバのインストール 

 

デバッガに ST-LINK/V2 を使用する場合は、下記手順に従ってドライバをインストールしてください。

(I-jet を使用する場合は不要です) 

STMicroelectronics 社のサイトにアクセスし、USB ドライバ(STSW-LINK009)をダウンロードしてく

ださい。 

https://www.st.com/content/st_com/ja/products/development-tools/software-development-

tools/stm32-software-development-tools/stm32-utilities/stsw-link009.html 

※ダウンロードの際にはユーザ登録が必要になります。 

 

 

図 5-1 STMicroelectronics 社サイトからの ST-LINK/V2 ドライバダウンロード 

 

ダウンロードしたファイルを任意のフォルダに解凍してインストーラを実行し、インストーラの指示

に従ってインストールしてください。 

  

https://www.st.com/content/st_com/ja/products/development-tools/software-development-tools/stm32-software-development-tools/stm32-utilities/stsw-link009.html
https://www.st.com/content/st_com/ja/products/development-tools/software-development-tools/stm32-software-development-tools/stm32-utilities/stsw-link009.html
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5.2. IAR Embedded Workbench でのソフトウェア開発 

 

5.2.1. 統合開発環境のインストール 

 

IAR 社のサイトにアクセスし、統合開発環境をダウンロードしてください。 

http://www.iar.com 

※ユーザ登録が必要になります。 

 

ダウンロード後、実行ファイルを起動し、「IAR Embedded Workbench のインストール」を選択します。 

 

 

図 5-2 インストーラ起動画面 

 

  

http://www.iar.com/
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5.2.2. 統合開発環境の起動 

 

スタートメニューから【IAR Embedded Workbench】を開いて起動してください。 

 

IAR 統合開発環境の初回起動時、ライセンスウィザードが表示されます。 

ライセンスをお持ちでない場合は、「IAR システムズに登録して評価用ライセンスを取得する(R)」を

選択してください。 

 

 

図 5-3 ライセンスウィザード画面 

 

ユーザ登録を行うと評価用ライセンスがメールで届きます。 

弊社提供のソフトウェアをカスタマイズする場合は、ユーザ登録時に必ず 

期間限定版(30 日間) 

を選択してください。 
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5.2.3. プロジェクトの起動 

 

弊社提供ソフトウェアの場合、ES920LR3\EWARM\Project.eww が IAR 統合開発環境のプロジェクト

ファイルになります。 

ファイル(F)→開く(O)→ワークスペース(W) 

から、当該ファイルを選択してください。 

※予め ES920LR3SDK CD に含まれる 04. ソースコード\ES920LR3.zip を任意のフォルダにコピーし

て解凍して下さい。 

 

下記はプロジェクトファイルを開いた時の例です。 

 

 

図 5-4 統合開発環境起動画面 
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5.2.4. プロジェクトのビルド 

 

プロジェクトのビルドは、 

プロジェクト(P)→すべてを再ビルド(B) 

を実行します。 

 

 

図 5-5 ビルド画面 
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5.2.5. 実行モジュールのダウンロード 

 

初回のみ、デバッガの種別を設定する必要があります。 

プロジェクト(ES920LR3)を右クリックし、 

[オプション(O)...] 

を選択してオプションダイアログを開きます。 

デバッガの種別に[I-jet/JTAGjet]あるいは[ST-LINK]を選択して、OK を押下して下さい。 

 

 

図 5-6 プロジェクトのオプションからのデバッガ種別選択 

 

  

右クリック 
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評価ボード(ES920LR3EB)の J1 ジャンパピンは VDD 側をショートし、コネクタ CN3 とデバッガを専

用ケーブルで接続してください。 

 

 

 

 

 

 

図 5-7 デバッガ接続のためのジャンパ設定と接続先コネクタ 

 

評価ボード(ES920LR3EB)と開発 PC を micro USB ケーブルで接続します。 

 

 

 

 

 

 

 

 

 

 

 

図 5-8 評価ボードと開発 PC を接続 
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実行モジュールのダウンロードは、 

[プロジェクト(P)]→[ダウンロードしてデバッグ(D)] 

を実行すると ES920LR3 の内蔵 FlashROM に実行ファイルがダウンロードされます。 

 

 

図 5-8 ダウンロード画面 
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実行ファイルがダウンロードされると main 関数で停止しますので、これ以降、デバッガによる操作

が可能になります。 

 

 

図 5-9 ダウンロード後画面 
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5.3. STM32CubeIDE でのソフトウェア開発 

 

5.3.1. 統合開発環境のインストール 

 

STMicroelectronics 社のサイトにアクセスし、統合開発環境(STM32CubeIDE)をダウンロードして下

さい。 

https://www.st.com/ja/development-tools/stm32cubeide.html 

※ダウンロードの際にはユーザ登録が必要になります。 

 

 

図 5-10 STM32CubeIDE ダウンロードページ 1 

 

ダウンロードしたファイルを任意のフォルダに解凍してインストーラを実行し、インストーラの指示

にしたがってインストールしてください。 

 

  

https://www.st.com/ja/development-tools/stm32cubeide.html
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5.3.2. 統合開発環境の起動 

 

スタートメニューから 

STM32CubeIDE 1.5.1 

を起動してください。 

 

任意のワークスペースフォルダを選択して開いてください。 

※ワークスペースフォルダは予めエクスプローラから新規作成して下さい。 

※フォルダ名は任意の名前で問題ありません。 

 

 

図 5-11 ワークスペースフォルダ選択画面 

 

  



特定小電力無線モジュール ES920LR3 

ソフトウェア開発環境説明書 

p. 38 

株式会社 EASEL 

 

5.3.3. プロジェクトのインポート 

 

初回のみメニューから[File]→[Import]を選択し、表示される画面から[General]→[Existing Projects 

into Workspace]を選択してください。 

 

 

図 5-12 プロジェクトインポート画面 1 
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続いて、Select root directory に弊社提供ソースコードのルートフォルダを選択します。 

※予め ES920LR3SDK CD に含まれる 04. ソースコード\ES920LR3.zip を任意のフォルダにコピー 

して解凍して下さい。 

 

 

図 5-13 プロジェクトインポート画面 2 

 

Projects にプロジェクトが 1 つ表示されるので、チェックされていることを確認して Finish を押下

します。 
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Project Explorer にプロジェクトが追加されていることを確認します。 

 

 

図 5-14 プロジェクトインポート後の画面 
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5.3.4. プロジェクトのビルド 

 

プロジェクトのビルドは、 

Project→Buil All (Ctrl+B) 

を実行します。 

 

 

図 5-15 ビルド画面 
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5.3.5. 実行モジュールのダウンロード 

 

評価ボード(ES920LR3EB)の J1 ジャンパピンは VDD 側をショートし、コネクタ CN3 とデバッガを専

用ケーブルで接続してください。 

 

 

 

 

 

 

図 5-16 デバッガ接続のためのジャンパ設定と接続先コネクタ 

 

評価ボード(ES920LR3EB)と開発 PC を micro USB ケーブルで接続します。 

 

 

 

 

 

 

 

 

 

 

 

図 5-17 評価ボードと開発 PC を接続 
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実行モジュールのダウンロードは、 

Run→Debug (F11) 

を実行します。 

ES920LR3 の内蔵 FlashROM に実行ファイルがダウンロードされます。 

 

 

図 5-18 ダウンロード画面 
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実行ファイルがダウンロードされると main 関数で停止しますので、これ以降、デバッガによる操作

が可能になります。 

 

 

図 5-19 ダウンロード後画面 

 

  



特定小電力無線モジュール ES920LR3 

ソフトウェア開発環境説明書 

p. 45 

株式会社 EASEL 

 

5.4. コード自動生成ツールの使用方法 

 

5.4.1. コード自動生成ツールのインストール 

 

STMicroelectronics 社のサイトにアクセスし、コード自動生成ツール(STM32CubeMX)をダウンロード

してください。 

https://www.st.com/content/st_com/en/products/development-tools/software-development-

tools/stm32-software-development-tools/stm32-configurators-and-code-generators/stm32cubemx.html 

 

動作確認済みバージョン 6.1.1 

 

 

図 5-20 STM32CubeMX ダウンロードページ 1 

 

ダウンロードしたファイルを任意のフォルダに解凍してインストーラを実行し、インストーラの指示

にしたがってインストールしてください。 

  

https://www.st.com/content/st_com/en/products/development-tools/software-development-tools/stm32-software-development-tools/stm32-configurators-and-code-generators/stm32cubemx.html
https://www.st.com/content/st_com/en/products/development-tools/software-development-tools/stm32-software-development-tools/stm32-configurators-and-code-generators/stm32cubemx.html
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5.4.2. コード自動生成ツールの起動 

 

スタートメニューから【STM32CubeMX】を開いて起動してください。 

 

5.4.3. プロジェクトの起動 

 

弊社提供ソフトウェアの場合、ES920LR3\ES920LR3.ioc がコード生成ツールのプロジェクトファイル

になります。 

File→Load Project... (Ctrl+L) 

から、当該ファイルを選択してください。 

 

下記はプロジェクトファイルを開いた時の例です。 

 

図 5-21 STM32CubeMX 画面 1 
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5.4.4. 機能カスタマイズ 

 

STM32CubeMX の画面にて、カスタマイズしたい箇所の変更を行って下さい。 

・Pinout& Configuration タブ … ピンアサインの変更 

・Clock Configuration タブ … クロック設定の変更 

 

 

図 5-22 STM32CubeMX 画面 2 

 

※ 間違った変更を行うと、ソフトウェア動作だけでなくハードウェアにも重大な影響を及ぼす場合が

ありますので、周辺回路やマイコンの機能を熟知した上で変更を行ってください。 

※ 割当済みのピンアサイン, GPIO の詳細設定は不用意に変更しないでください。 

無線機能、デバッグ機能、タイマー等が正常動作しなくなる恐れがあります。 

※ クロック設定は不用意に変更しないでください。 

無線機能やスリープ機能が正常動作しなくなる恐れがあります。 

※ SPI1、NVIC、DMA の既存の設定内容は不用意に変更しないでください。 

無線機能が正常動作しなくなる恐れがあります。 
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5.4.5. コード生成 

 

※コード生成を行う前に、統合開発環境のプロジェクトやソースコードを全て閉じて下さい。 

※コード生成を行うと、既存のソースコード・プロジェクトファイルに対して変更が行われます。意図

しないコード削除・変更が行われる可能性を考慮して、コード生成前に全てのソースコードをフォル

ダごとバックアップすることを推奨します。 

 

Project Manager タブを選択して下さい。 

 

図 5-23 STM32CubeMX 画面 3 

 

Toolchain / IDE のプルダウンメニューから、使用する統合開発環境を選択してください。 

・EWARM V8 … IAR Embedded workbench for Arm v8.xx 

・STM32CubeIDE … STM32CubeIDE 

※複数の統合開発環境を使用する場合は、本項記載の一連の手順を繰り返して、それぞれの統合開発環

境に対してコード生成を行ってください。 
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【Generate Under Root】のチェックを外して、GENERATE CODE を押下してください。 

 

図 5-24 STM32CubeMX 画面 4 

 

※コード生成後、変更前後のソースコードを比較して、意図した通りに変更されていることを確認す

ることを推奨します。 

 

コード自動生成ツールでの変更をモジュールに反映するには、統合開発環境(IAR EWARM 又は

STM32CubeIDE)にてビルド後、実行モジュールを ES920LR3 にダウンロードする必要があります。 
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